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Installing Dbank/Dbank Files on a Network Drive

Installing Dbank on a Network Drive:

Dbank can be installed on a network drive (i.e., a drive that can be accessed by more than one user at 
the same time), but usually at the cost of performance.    Use Dbank's SETUP.EXE program to install 
Dbank directly to the network drive.    Individual users then need to create a program item which points to 
the network version of DBANK.EXE (e.g., I:\DBANK\DBANK.EXE), and make their Windows "network-
aware".

The four *.bat files distributed with Dbank give a pratical example how to install Dbank on a network using
a character based interface.    On this particular network (i.e., NUSNET) Dbank is installed on I:\DBANK (a
read-only directory), and all clients have a private directory on h:.    Note that Windows is not installed on 
the network; we require each user to have a copy of Windows on their local drive.    The *.BAT files 
determine the location of win.com on the client's hard disk, and then invoke DBANK.EXE on I:\DBANK 
directly.    The clients' version of Windows (*.GRP and *.INI files) are not modified in any way.

Installing Dbank data banks on a network drive:

A Dbank data bank can be installed on a shared network drive; however, it must be converted to "read-
only" before it is copied to such a drive.    Read-only data banks are created using Dbank's "Attribute 
Read-Only" command.

IMPORTANT: This version of Dbank does not support write-enabled data banks in a multi-user 
network environment.    We advise that you do not install write-enabled data banks to a shared 
network drive.    While Dbank will still work and be able to access the data in the data bank as 
usual, there could be serious problems when two or more users attempt to simultaneously write 
different data to the same series.    Also, if one user deletes or renames any series, other current 
users of the same data bank will not be informed of the changes until they refresh their copy of 
the group and list boxes.    (Future versions of Dbank may support multi-user write capability if 
there is interest.    Send your comments/suggestions to fbaso@nus.sg)

[The above also applies to non-networked users that run multiple instances of Dbank to access 
the same write-enabled data bank!]

Every Dbank data bank has two (2) files associated with it:

<databank_name>.MDB, and
<databank_name>.FDB

where "<databank_name>" should be replaced with the actual name of the data bank.    The ".MDB" file (a
Microsoft Access database) contains the index records of the series, while the ".FDB" file contains the 
data saved in IEEE binary format.

To install a data bank on a network drive, simply copy both files to the network drive (or use Dbank's File 
Copy command).    After you have done so, make sure you set the file attribute of <databank_name>.mdb 
and <databank_name>.fdb to "+r" (i.e., read-only) using the DOS ATTRIB command.    This will permit 
multi-user access to the data bank.

You may set the data bank's attribute to +h +s to hide the data bank.    Dbank will still be able to locate the



data bank.

Dbank can also create "network-only" data banks -- i.e., data banks which can be read by Dbank only if 
they reside on a network drive.    This prevents users from making private, usable copies of the data bank.
Please send e-mail to fbaso@nus.sg for further information on how to create "network-only" data banks 
(the command to do so is hidden and password-protected).

Dbank and all of its data banks can run directly from a CD-ROM with no prior setup except possibly for 
the pre-loading of the DOS utility SHARE.EXE.    Except for the physical limitations imposed by virtual 
memory and free hard disk space,    Dbank does not limit the number of data banks that a user can 
create.    There is no limit on number of groups in a single data bank, nor on the number of series in a 
particular group; and there is no practical limit on the number of observations attached to a particular 
time-series.    Thus Dbank provides an efficient and flexible method of distributing large amounts of time-
series and cross-sectional data.

Dbank file formats are relatively straight-forward to understand and can be easily read by many standard 
programming languages (e.g., Microsoft Visual Basic,    Microsoft Visual C++, Microsoft Powerstation 
Fortran, etc).    Documentation on the file structure can be obtained by sending a request to 
fbaso@nus.sg
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Decimal Separator, Thousands Separator, and the Default List Separator

Dbank was written and debugged using the following (USA) settings for the following Windows 
separators:

Decimal Separator: . (period)
Thousands Separator: , (comma)
List Separator: , (comma)

Dbank 94-7 allows you to set arbitrary characters for these separators, but it is not thoroughly tested.    To 
achieve the most reliable and hassle free performance possible from Dbank, we suggest that you use the 
above separators.    Also, avoid setting the decimal and list separators to the same character 
(especially ";" or ":").    Window's default separators are changed using "Control Panel".    Double-click 
on "International" to do so.



What Went Wrong (Bugs Fixed)

There were a quite a few serious bugs in the 93-7/94-1 releases of Dbank.    They have been fixed.    Here
is the serious bug list as of 30-June 1994:

1. Dbank failed to set its missing value code on machines without a co-processor. Symptoms: 
Dbank starts, but nothing works.

2. Dbank failed to return to the current data bank if Tagged View or Tagged Peek was invoked 
to operate on a series residing in another data bank.    Symptoms:    Dbank could not locate any of 
groups/series currently shown in the group and series list boxes because the "current data bank pointer" 
was mangled.

3. ACE generated a fatal run-time error if EXCEL was not present on host machine.    
Symptoms:    ACE ran okay, but failed when it attempted to plot the optimal transformations.

4. Dbank "failed" to set its missing value code on machines which set the Windows decimal 
separator to anything but "." (i.e., period).

There were numerous minor bug fixes.



What's New

1 Series Link.    You can "link" to series in a data bank.    This feature means that you can have 
more than one name for the same time-series data.    See "Help Series Link" for more information.

2 Series and Group Memo.    You can now attach lengthy descriptions to data banks, groups, and 
individual time-series.    See the individual help items on the File, Group, and Series Memo command for 
more information.

3. New input formats:    Dbank can now read the following input formats/data files:

(a) CITIBASE ASCII (TAPE) file format (default extension: .cty).
(b) AREMOS file format (default extension: .fre)
(c) GAUSS binary files --- ".FMT" and ".DHT" files (16/32 bit)

Suggestions for additional input/output formats are most welcome and will be implemented (time 
permitting).    Please send complete documentation (together with a example of a valid input/output 
ASCII file) to fbaso@nus.sg.

Requests for Dbank to write BINARY output files directly will probably not be implemented.    With the 
notable exception of the fairly standard LOTUS *.WK1 binary format, we have decided to avoid writing 
BINARY output files.    This way you can be sure that if the BINARY data file is unreadable, Dbank is not 
to blame.

4. The maximum length for series titles, group labels, and file captions is now 255 characters (up 
from 80 characters).    This feature does not increase the size of your data bank unless you increase the 
size of the series titles, etc.

NOTE: you need to squeeze you data banks to take advantage of the larger title length.

5. Group Change command.    This command allows you to change the default group in the active 
data bank from the keyboard.

6. Abort Feature:    it is now possible to abort/terminate Series Add Data/File Add Data/File 
Dump.    Press CTRL+BREAK or CTRL+C    to do so.

7. Improved Editor: you can now edit more than one series, provided the selected series have the 
same frequency.    Click on the Grid control and press F2 or ENTER to commence your editing session.

8. New conversion methods:    you can now convert a series to a lower frequency using the 
"minimum" or "maximum" of the data in the appropriate sub-period.

9. Multiple selection on input: you can now select more than one input file; i.e., multiple input file 
selection is now possible.

10. "Series Make" LAG( ) function now accepts    TO: In "Series Make", the syntax    x = lag(y, 1 
TO n) generates    n    variables, one of each lag --- i.e., 1, 2, 3, 4, .. Refer to Help Series Make for more 
information.



11. "ReMake" function implemented (recursive, non-recursive):    The "ReMake" command 
updates (i.e., re-generates) all the series in the data bank previously created with the "Series Make" 
command.    Dbank can regenerate series recursively, or non-recursively.    With recursive ReMake,    
Dbank performs a "spreadsheet style" recalculation of all the derived series in the data bank.    For 
example, if x = log(y), and y = abs(bal_paym),    Dbank updates y BEFORE computing x.    With non-
recursive ReMake,    Dbank computes x = log(y) without updating y.

"ReMake" is typically used immediately after data are updated.

12. Make on Input Implemented:    You can include "Make" commands in Dbank FREE formatted 
files.    Dbank will generate the derived series as it is reading the data in the file.    Thus, 

make x = log(y)

is understood in (and only in) Dbank FREE format files.

13. VIEW Procedure improved: Dbank's VIEW(er) as been overhauled    Gone are the restrictions 
on the number of observations in a series, and on the number of series.    Also, VIEW doesn't read all the 
data before displaying a subset of the data.    This yields much faster performance.

The enhancements to VIEW made PEEK redundant, so it was removed.

14.    DISTRIBUTION Agreement changed:    Dbank's distribution agreement has been revised to allow 
reselling of the product by third-parties.    There have been some price revisions.    Please refer to the 
distribution agreement for more details.

15.    INTERNATIONALIZATION ISSUES:    Dbank is now "internationally" aware.    That is, it recognizes 
and adapts to your settings for the Windows list, thousands, and decimal separator.    Hence, if you set the
decimal separator to "," (i.e., comma), "123.678" is a non-numeric number on input.    However, 
"123,678" is numeric.

Please ensure that your input format conforms to the settings you are using for the list, thousands and 
decimal separators.    Alternatively, you can change the default settings for the above separators to be 
consistent with your desired input format.    Double-click on "Control Panel" and then "International" to do 
so.

Dbank will adapt to the new settings for the separators immediately.    You do not need to re-start 
Dbank.



Exporting Data to Other Programs

An important feature of Dbank is its ability to transfer data to files that can be processed immediately by 
other programs.    Dbank's EXPORT command implements this feature. 

You must select (i.e., tag) the series to export before invoking the EXPORT form.    You can tag series 
using the TAG command in the GROUP and SERIES menus.    You can also tag series by    double-
clicking on a series, or selecting groups and/or series using the mouse and then clicking the RIGHT 
mouse button.

The Tagged EXPORT command loads Dbank's EXPORT form which requires you to specify:

(a) the sample period for the copy.    The sample period determines which part of the tagged 
series to copy;

(b) the output format (i.e., the structure of the output file);

(c) (if unknown) the conversion method Dbank should use when it needs to convert a series to a 
lower frequency (e.g., from quarterly to annual); and, 

(d) the name of the output file (i.e., the destination of the copied series).

Dbank will not allow you to export any series until at least ALL of the following parameters have been set:

(a) the sample period;
(b) the output format; and
(c) the name of the output file.

If you find the above confusing,    try tagging a few series and then invoking "Tagged Export".    You will 
find that Dbank's EXPORT form is programmed to step you through the export process.



Dbank Quick Guide

Do you have a lot of data on your hard disk but have little or no idea which files have what data?    Do you 
find it difficult to extract a subset of those data for use with other programs?    Would you like to organize 
the data on your hard disk so that they are easy to locate?

Dbank is a network-ready, tree-structured filing system for time series and cross-sectional data that runs 
under Microsoft Windows(TM).    In addition to providing numerous commands for managing, 
manipulating, viewing and plotting such data, Dbank allows you to export the data to many statistical 
packages and spreadsheet programs.    Dbank also has built-in multiple regression and ACE modules that
provide p-values if you have access to Microsoft Excel.

Dbank may be useful to people who need the same data in different formats because they routinely use 
more than one statistical/spreadsheet package to analyze their data; and it is likely to be especially useful
in corporations and institutions with large databases that need to be shared with many users at different 
workstations.    

Dbank has been found to be especially useful in university environments where there are typically many 
users of the same data, but where users require different ASCII formats of the same data.    Dbank 
provides a user-friendly solution to this common problem, and can be run directly from a network server 
without any user installation.

If you would like to experiment with Dbank, double-click on EXAMPLE.MDB (a data bank) in Dbank's file 
list box.    This will allow you to play with Dbank's Group, Series, and Tagged Menus.

For starters, click on the group called FIRST.    Then, from the Group Menu, select Mosaic Time Plot 
(Alt+G+L).    Dbank will plot all the series in FIRST (and its sub-groups) against time.    To view the data in 
the series called BPASPV, double click on the FIRST group in the group list box, and then click on the 
sub-group BP.    This will fill the series list box with all the series in the group called [FIRST.BP]. Then click
on BPASPV in the series list box, and from the Series Menu select View (ALT+S+W).

If you tag any of the series (right-click on any highlighted group(s) or series name(s) to do so), Dbank will 
enable the Tagged Menu (which operates on the series in the tagged list box).    The tagged list box can 
collect series from any number of different data banks for processing together.

"Mouse Commands" under the Help Menu gives instructions on selection of items using the mouse.

Note that Dbank is hierarchical up to the series list box:

Drive:\Directory\File[Group.Group. ... .Group]Series

whereas the tagged list box only contains series collected by you from the group or series list box.    For 
example, BPASPV appears in the hierarchy:    I:\DBANK\EXAMPLE[FIRST.BP]BPASPV

If you have a rectangular data set saved in an ASCII file (i.e., the data is organized as a matrix, with each 
row in the file representing an observation and each column representing all the observations on a 
particular series), you can import it into Dbank using the "Add Data..." command in Dbank's File Menu.

The "Add Data..." command will create a data bank with the same name as the input file; double-click on 
the new data bank to open it.    You can manipulate the series in the data bank using Dbank's Group and 
Series Menus.



If you don't have a rectangular data set handy, use EXAMPLE.MAT.    Dbank's SETUP program copied 
EXAMPLE.MAT to the same directory in which you installed Dbank.

To manually input data, simply click on the input icon.

Dbank provides context-sensitive help.    Also, if the mouse pointer remains over an icon for more than 
one second, a short help message will appear at the top of the form.

Lastly, Dbank and all of its data banks can run directly from a CD-ROM with no prior setup except 
possibly for the pre-loading of the DOS utility SHARE.EXE.    Except for the physical limitations imposed 
by virtual memory and free hard disk space,    Dbank does not limit the number of data banks that a user 
can create.    There is no limit on number of groups in a single data bank, nor on the number of series in a 
particular group; and there is no practical limit on the number of observations attached to a particular 
time-series.    Thus Dbank provides an efficient and flexible method of distributing large amounts of time-
series and cross-sectional data.

DISCLAIMER

Every attempt has been made to free Dbank of bugs and to ensure that the program operates as 
documented.    However, the author disclaims all warranties as to this software, whether expressed or 
implied, including without limitation any implied warranties of merchantability, fitness for a particular 
purpose, functionality or data integrity or protection.    In particular, in no event shall the author be liable for
consequential, incidental or indirect damages of any kind arising out of the delivery, performance or use of
Dbank.

In other (less legalistic) words, please use this program as if you wrote it yourself, and be just as 
understanding when you run into a bug.

Dbank is Copyright 1993-94, by Sam Ouliaris.    All rights reserved.



File Menu

Dbank's File Menu has all the commands Dbank provides for managing Dbank data banks.    The data 
bank commands supported are:

Open Command
Close Command
Query Command
Tree Command
Attribute Command
Caption Command
Copy Command
Delete Command
Dump Command
Make Command
Memo Command
Move Command
ReMake Command
Rename Command
Repair Command
Update Command
Squeeze Command
Add Data Command
Utilities Command
Print Form
Exit Command

Dbank data banks consist of two files: (a) an ".MDB" file, which is a Microsoft Access Database; and (b) 
an ".FDB" file, which contains data saved in IEEE binary format (single and/or double precision).    Dbank 
data banks can therefore also be managed (e.g., copied, renamed, deleted, backed up, etc.) using the 
usual MS-DOS file commands.



Group Menu

Dbank's Group Menu has all the commands that Dbank provides to manipulate groups within a data 
bank.    The commands available under the Group Menu are:

Browse Command
Change Command
Copy Command
Delete Command
Edit Command
Label Command
Make Command
Memo Command
Move Command
Query Command
ReMake Command
Rename Command
Sort Command
Tag Command
UnTag Command
View Command
Xdelete Command
Print Command
Print Index Command
Mosaic Time Plot Command
Summary Statistics Command



Mouse Commands

The mouse can be used to select an item in a list box.    To select a single item, click on any item in a list 
box.    Multiple selection is also possible: simply drag the mouse over the contiguous items you wish to 
select.    Shift+click or Shift+arrow key (like dragging) extends the selection from the previously selected 
item to the current item.    Ctrl+click selects or de-selects an item at a time.    Ctrl+(mouse drag) is a like a 
combination of Ctrl+click and drag: it allows selection of disjoint clusters of items in a list box.

Double clicking in the group list box moves up or down the data bank's hierarchical tree-structure.    
Double clicking a series in the series list box tags the series; and that series then appears in the tagged 
list box.    Double clicking on any item in the tagged list box sends that item to the end of the tagged list 
box.

The RIGHT mouse button generally sends highlighted items from a list box to elsewhere.    For example, a
RIGHT click in the group list box copies all the series in the highlighted groups to the tagged list box.    
Right clicking in the series list box likewise copies all the highlighted series to the tagged list box.    A 
RIGHT click in the tagged list box deletes all the highlighted series in the tagged list box; if no series is 
highlighted, all the series in the tagged list box are removed.

Double clicking on a file in the file list box opens the corresponding data bank.    If you then right click on 
the same file name (i.e., the active data bank), the data bank is closed.    Most of Dbank's File commands 
support multiple selection in the file list box.



Tagged Menu

Dbank's Tagged Menu allows you to execute commands on ALL or a subset of the series that you have 
placed in the tagged list box.    The commands available under the Tagged Menu are:

Browse Command
Copy Command
Delete Command
Edit Command
Move Command
ReMake Command
Rename Command
Sort Command
UnTag Command
View Command
Print Command
Print Index Command
ACE Command
Export Command
Mosaic Single Y vs Xs Plot Command
Mosaic (X,Y) Pairs Plot Command 
Mosaic Time Plot Command
OLS-IV-2SLS Regression Command
Scatter Plot Command
Summary Statistics Command
Time Plot Command



Series Menu

Dbank's Series Menu allows you to execute commands on series within a group.    The following 
commands are available in the Series Menu:

Add Data Command
Browse Command
Convert Command
Copy Command
Delete Command
Edit Command
Input Command
Link Command
Make Command
Memo Command
Move Command
ReMake Command
Rename Command
Sort Command
Tag Command
UnTag Command
View Command
Print Command
Print Index Command
Probability Density Estimate
Scatter Plot Command
Summary Statistics Command
Time Plot Command



Dbank Quick Help

1. How do I start Dbank?

From the Program Manager, double-click on the Dbank icon. 

If you have Windows 3.1 or greater, you can also start Dbank by typing "Dbank" at the DOS 
prompt, provided Windows is not already running and win.com is on the current path.

2. How do I start Dbank with a user-specified data bank already opened?

Dbank accepts a single argument (a fully qualified data bank name) on the command line.    Thus,
to automatically open the data bank EXAMPLE.MDB whenever Dbank is started, type

Dbank C:\DB\EXAMPLE

3. How do I create an empty data bank?

From the File Menu, choose "Make" (Alt+F+K).

4. How do I open an existing data bank?

From the file list box,    double-click on the data bank you wish to open.    For example, double-
clicking on EXAMPLE.MDB opens the data bank.    The distributed version of EXAMPLE.MDB has three 
groups: FIRST, SECOND, and ACE.    These groups will appear in the group list box when you open the 
data bank for the first time.

FIRST has a sub-group called BP.    If you double click on FIRST, Dbank will set the default group to 
FIRST and then fill the group list box with all the groups that belong to FIRST (i.e., BP).

5. How do I delete a data bank?

Select a data bank to delete using the mouse; i.e., click on a data bank in the file list box. To 
actually delete the file, click on the File Menu and choose "Delete" (Alt+F+D)

6. Suppose I have data in a file called EXAMPLE.MAT which are organized as a matrix (i.e., in 
rows and columns).      How can the data be read into Dbank?

From the File menu, select "Add Data..." (Alt+F+A).    This invokes the File Open dialog box.    
Type EXAMPLE.MAT and then click on the OK button of the File Open dialog box.

Provided EXAMPLE.MAT exists, Dbank will create a data bank called EXAMPLE.MDB (assuming
one does not exist already) with a group called EXAMPLE.    The series in EXAMPLE.MAT    will be saved 
in EXAMPLE and the series in EXAMPLE will be called C1, C2, C3, .., CN    where N is the number of 
columns (i.e., series) in EXAMPLE.MAT.

7. How do I create a group called "THIRD" with a sub-group "GNP"    in EXAMPLE.MDB?

(a) If necessary, open the data bank by double-clicking on EXAMPLE.MDB in the file list box.

(b) From the Group Menu, select "Make" (Alt+G+M) and then type "THIRD.GNP".

8. How do I print all the series in the group called "SECOND" in EXAMPLE.MDB?

(a) If necessary, open the data bank by double-clicking on EXAMPLE.MDB in the file list box.



(b) Click on the group called SECOND in the group list box.

(c) From the Group Menu, select "Print" (Alt+G+P).

9. How do I export ALL the series in the group called "FIRST" and its sub-groups directly to 
an EXCEL spreadsheet using Windows' Dynamic Data Exchange facility?

(Follow these steps only if you have access to Microsoft EXCEL.)

(a) Open the data bank by double-clicking on EXAMPLE.MDB in the file list box.

(b) Click on the group called "FIRST" in the group list box.

(c) Tag all the series in FIRST by selecting "Tag" from the Group Menu (Alt+G+T).

(d) From the Tagged Menu, select "Export..." (Alt+T+X).    This will invoke Dbank's EXPORT 
form.

(e) From the Format Menu of the EXPORT form, select "DDE to EXCEL" to indicate 
"Dynamic Data Exchange" to an Excel spreadsheet.

(f) Indicate the range of observations to export by clicking on the Bounds button of the 
EXPORT form.

(g) From the File Menu, declare an output file (i.e., spreadsheet) for the tagged series by 
selecting "Open..." (Alt+F+O)

(h) Click on the "Do it!" button of the EXPORT form.    Dbank will start copying the tagged 
series to an Excel spreadsheet.

The EXPORT form is programmed to take you through steps (e)-(g).

10. How do I run ACE on a set of series?

(a) The first step is to tag all the series you wish to run ACE on.    To tag all the series in a 
group, from the Group Menu, select "Tag" (Alt+G+T) or simply select the group using the mouse and then 
click on the RIGHT mouse button.    To tag a particular series within a group, from the Series Menu, select
"Tag"    (ALT+S+T) or double-click on the series name.

(b) Invoke ACE.    To do so, from the Tagged Menu,    select "ACE".

11. How do I rename a series in EXAMPLE.MDB?

Select the series you wish to rename using the mouse.    Then invoke the Series Menu, and select
"Rename" (ALT+S+R).

12. How do I rename a group in EXAMPLE.MDB?

Indicate the group you wish to rename by clicking on a particular group in the group list box.    
Then invoke the Group Menu, and select "Rename" (Alt+G+R).

13. How do I delete ALL the series in a particular group and its sub-groups; for example, all 
the series in the group called "FIRST" and its sub-groups?

Click on the group called FIRST in the group list box.      From the file menu,    select "XDELETE".   



(Alt+G+X).

14. How do I get a mosaic plot of ALL the series in a group and its sub-groups?

The first step is to tag the group (click on the group using the mouse and press 't').    To plot the 
series, from the Tagged Menu, select "Mosaic Time Plot" (Alt+T+T).

15. How do I get a plot of a single series against time?

Click on the series you wish to plot using the mouse.    From the Series Menu, select "Time Plot". 
(ALT+S+L)

16. How do I inspect the data in a particular series?

Click on the series you wish to view.    From the Series Menu, select "View" (ALT+S+V).

17. How do I edit the data in a particular series?

Click on the series you wish to edit.    From the Edit Menu, select "Edit" (ALT+S+E).

18. How do I compute the growth rate of a series using Dbank's Series Make facility?

Suppose you need to compute the growth rate of BPB, a series in the group called FIRST, and 
you want to save the result in a series called GBPB in a group called GROWTH.USA

(a) Double click on the group called FIRST and then click on the sub-group called BP.

(b) From the Series Menu, select "Make" and enter:

[growth.usa]gbpb = ((bpb-lag(bpb))/lag(bpb))*100.

Dbank will create a series called GBPB in the group "GROWTH.USA" containing the (quarterly) 
growth rate of BPB.

19. Is it possible to select more than one item in the group, series, and tagged list boxes?

The group, series and tagged list boxes allow you to select multiple items.    To do so using the 
mouse, hold the left mouse button down and drag the cursor over the items you wish to select.    

Shift+click or Shift+arrow key extends the selection from the previously selected item to the 
current item. Ctrl+click selects or de-selects an item in the list.



Introduction

Dbank is a network-ready, tree-structured filing system for time series and cross-sectional data that runs 
under Microsoft Windows(TM).    In addition to providing commands which allow you to create data banks 
and manipulate the data stored inside them, Dbank allows you to easily export the data to many statistical
packages and spreadsheet programs.    Dbank also provides basic statistical tools for analyzing data.

Dbank may be useful to people who need the same data in different formats because they routinely use 
more than one statistical/spreadsheet package to analyze their data; and it is likely to be useful in 
corporations and institutions with large databases that need to be shared with many users at different 
workstations.

Dbank has been found to be especially useful in university environments where there are typically many 
users of the same dataset, but where users require different ASCII formats of the data. Dbank provides a 
user-friendly solution to this common problem, and can be run directly from a network server without any 
user installation.

Dbank files are typically organized into groups of series.    A series is simply a collection of data.    For 
example, data on the Gross National Product of the USA for 1949-1991 (a total of 43 observations) could 
be regarded as a series.    A "group" within Dbank is simply a collection of (possibly) related series.    For 
example,    all the series used in a research paper could be called a group.    Dbank's filing system for 
groups of series is similar to the MS-DOS filing system.    Every data bank has a main group (or "root" 
directory) which is the point of growth for all other groups in the data bank.    Every group except the main 
group has a parent group, and any group can have one or more sub-groups (or "children").

Dbank's data management commands can be applied either to a single series within a group or to all the 
series in a particular group.    You can also define a temporary group using Dbank's TAG facility.    The 
tagged series can then be manipulated as a single group.

Dbank provides a number of commands for managing your data.    You can ADD series to the data bank, 
EDIT the data stored in a series, INPUT data into Dbank, MOVE a series from one group to another, and 
COPY a series to a new series, another group or even to a different data bank.    There is also a 
command to DELETE a series, one to VIEW the data stored in a series, a RENAME command, and a 
PRINT command.    Many of these commands operate on a group of series, and on the series you place 
in the tagged group.

Dbank also helps you manage your data bank files.    There are functions to create, delete, copy, move, 
rename and squeeze data banks.    READ-ONLY data banks, which are particularly useful in network 
environments, may also be created.

After you have saved your data in a Dbank data bank, you can easily export your data to any of the 
following statistical/spreadsheet packages:

1) AREMOS
2) TSP
3) Micro TSP
4) GAUSS
5) LIMDEP
6) LOTUS, QUATTRO, EXCEL
7) SAS



8) SST
9) MINITAB,
10) RATS
11) BMDP
12) SPSS.

If necessary,    Dbank will convert your data to a lower frequency during the export process (i.e., copying 
your data to a file that can be read by another program).    For example, it will convert daily data to 
monthly data, and monthly data to annual data.

Dbank can mask a series during the export process.    It has a filter function which allows you to copy an 
observation in a series depending on the value taken by another series.    The filter function is useful for 
cross-sectional data.

Dbank also has its own "FREE", "MATRIX" and "SERIES" file formats.    These formats can be read by 
most programming languages (e.g., FORTRAN).

Dbank can also read the following proprietary file formats: (a) CITIBASE TAPE FORMAT (ASCII); (b) 
AREMOS ".TSD" format (ASCII); and (c) Aptech's GAUSS ".DHT" and ".FMT" binary formats (16/32 bits).

If you have a copy of Microsoft's EXCEL program,    Dbank can import and export data directly from/to 
EXCEL spreadsheets using Window's Dynamic Data Exchange (DDE) facility.

Dbank can manage data with ANNUAL, HALF-YEARLY, QUARTERLY, MONTHLY, WEEKLY and DAILY 
frequency (which allows you to specify a 5, 6, or 7 day cycle).    Dbank also has a NULL frequency which 
is particularly useful for cross-sectional data.

Lastly, Dbank and all of its data banks can run directly from a CD-ROM with no prior setup except 
possibly for the pre-loading of the DOS utility SHARE.EXE.    Except for the physical limitations imposed 
by virtual memory and available hard disk space,    Dbank does not limit the number of data banks that a 
user can create.    There is no limit on number of groups in a single data bank, nor on the number of 
series in a particular group; and there is no practical limit on the number of observations attached to a 
particular time-series.    Thus Dbank provides an efficient and flexible method of distributing large amounts
of time-series and cross-sectional data.



DBANK form

Dbank's startup form is shown above.    The important areas of this form are:

1. File List Box:    this list box contains all the data banks (i.e., files with extension: .MDB) in the 
user's default or current directory.

2. Directory List Box: this list box shows the default directory (currently C:\DB) and all of the sub-
directories beneath the default directory.    You can change the default directory using the keyboard or 
mouse.    The contents of the file list box are updated when you do so.

3. Disk List Box: this list box contains all the accessible (including network) drives.    The current 
drive and its label are shown in the body of the drive list box.    In the above form, the current drive is    C    
with a label of    MS_DOS_6

4. Group List Box:    this list box appears after you successfully open a data bank.    It contains all 
the groups in the active data bank. The active group is indicated by the black control bar (currently BP, 
which belongs to the group called FIRST ) in the group list box. Data bank operations (such as COPY, 
MOVE,    RENAME,    DELETE, and XDELETE) on a group can be executed from the GROUP menu.

Dbank data banks possess a hierarchical tree structure similar to the MS-DOS file system.    Double-
clicking on a group fills the group list box with the names of the groups that belong to that group (and so 
on to any number of levels).    Double-clicking on the parent ( ..FIRST    above) moves you up one level in 



the tree.    Double-clicking on the main group (    1:[]    above )    moves you to the main or root group in the
data bank.

5. Series List box:    this list box appears after you successfully open a data bank.    It contains all 
the series in the default group.    The current series (i.e., the series that will be affected by the next 
SERIES Menu command) is indicated by the black control bar (currently BPASPV).    Individual series are 
managed using the SERIES Menu.

6. Tag List Box:    this list box once you tag a series.    You can tag a group of series using the TAG 
command in the GROUP menu, or a single series using the TAG command in the SERIES menu.    You 
can also tag series/groups using the mouse; simply double-click on the object you wish to tag.    In the 
above form, some of the series in the "FIRST" group    have been tagged.    Note that tagged series have 
a superscript "1" appended to their name.    The superscript flags their "tagged" status.

7. File Menu:    contains all the commands Dbank provides to create and manipulate data bank files.
Click on the FILE menu to invoke one of these commands, or type Alt+F.

8. Group Menu:    contains all the commands Dbank provides to create and manipulate the groups 
(and the associated sub-groups) in a data bank.    Click on the GROUP menu to invoke one of these 
commands, or type Alt+G.

9. Series Menu:    contains all the commands Dbank provides to create and manipulate the series in
the series list box.    Click on the SERIES menu to invoke one of these commands, or type ALT+S.

10. Tagged Menu:    contains all the commands Dbank provides to manipulate the series in the 
tagged list box. Click on the TAGGED menu to invoke one of theses commands, or type Alt+T.

11. Filing Cabinet Icon:  when the cabinet is closed, clicking the icon opens the highlighted data 
bank.    If the cabinet is open, clicking on the icon closes the active data bank.

12. Tree Icon:    click on this icon to invoke Dbank's "File Tree" command which provides a visual 
representation of a data bank's structure.

13. SQL Icon:    click on this icon to invoke Dbank's "File SQL Query" command which allows your to 
execute SQL queries on Dbank data banks.

14. Series Input Icon:    click on this icon to invoke Dbank's "Series Input" command which allows 
you to manually input data into a Dbank data bank.

15. Add Data Icon: click on this icon to invoke Dbank's "Add Data" command which allows you to 
add data to a new or existing data bank.

16. Export Icon:  click on this icon to invoke Dbank's "Tagged Export" command which allows you to 
export the series in the tagged list box to many popular statistical/spreadsheet programs.

17. Scatter Plot:    click on this icon to invoke Dbank's "Scatter Plot" command which provides a 
scatter plot of any two series in the active list box.

18. Time Plot Icon:  click on this icon to invoke Dbank's "Multiple Time Plot" command which plots 



up to fourteen (14) series in the active list box against time (on a single axis).

19. Mosaic Plot Icon:  click on this icon to invoke Dbank's "Mosaic Plot Command" which provides a
mosaic nail plot of all/subset of the series in the active list box.

20. Browse Icon: click on this icon to invoke Dbank's "Browse" command which invokes Dbank's 
Browse module on all/subset of the series in the active list box.

21. View Icon:  click on this icon to invoke Dbank's "View" command which invokes Dbank's View 
module on all/subset of the series in the active list box.

22. Edit Icon:  click on this icon to invoke Dbank's "Edit" command which invokes Dbank's Series 
Editor on all/subset of the series in the active list box.

23. Statistics Icon:  click on this icon to invoke Dbank's "Summary Statistics" command which 
invokes Dbank's Summary Statistics module on all/subset of the series in the active list box.

24. OLS/2SLS/AR(1) Icon:  click on this icon to invoke Dbank's "Tagged OLS/2SLS/IV" command 
which invokes Dbank's regression module.

25. ACE Icon:  click on this icon to invoke Dbank's "Tagged ACE" command which invokes Dbank's 
ACE module for all/subset of the series in the tagged list box.

26. Excel Icon: click on this icon to invoke Microsoft Excel (if available).

27. Calculator Icon: click on this icon to invoke Calculator.EXE (if available).

28. MS-DOS Icon: click on this icon to shell to DOS (if possible).

29. Printer Icon:    click on this icon to invoke Dbank's "Printer Setup" command which allows you to 
permanently change printer settings.



File List Box

Dbank's file list box contains all the data banks (i.e., all the    *.mdb    files) in the current directory.

The file list box allows you to make single and multiple selections.    To select a single file, click on a file 
using the mouse.    Shift+click or Shift+arrow key extends the selection from the previously selected item 
to the current item. Ctrl+click selects or de-selects an item in the list.



Directory List Box

The directory list box contains all the directories on the current drive.    You can select a directory using 
the keyboard or mouse.    Dbank updates the file list box whenever you change the default directory.



Drive List Box

The drive list box contains all the drives that your PC can access (including network drives).    The default 
drive is shown in the body of the list box.    You can change to another drive by clicking on the drive list 
box using the mouse.    Dbank updates the file and directory list boxes whenever you change the default 
drive.



Group List Box

The group list box contains all the groups in the current data bank.    You can select a group using the 
keyboard or mouse.    Dbank updates the series list box whenever you select another group.    Data bank 
operations on the group (and thus the series within the group) can be carried out using the Group Menu.

Dbank data banks possess a hierarchical tree structure similar to the MS-DOS file system.    Double-
clicking on a group fills the group list box with the names of the groups that belong to that group (and so 
on to any number of levels).    Double-clicking on the parent group moves you up one level in the tree.    
Double-clicking on the main group moves you to the main or root group in the data bank.

The group list box allows you to make single or multiple selections.    To select a single group, click on a 
group using the mouse.    Shift+click or Shift+arrow key extends the selection from the previously selected
group to the current group. Ctrl+click selects or de-selects a group in the list.



Series List Box

The series list box contains all the series in the current group.    You can select a series using the 
keyboard or mouse.    Data bank operations on the series can be carried out via the SERIES menu.

The series list box allows you to make single or multiple selections.    To select a single series, click on the
series using the mouse.    Shift+click or Shift+arrow key extends the selection from the previously selected
series to the current series.    Ctrl+click selects or de-selects a series in the list.



Tagged List Box

The tagged list box contains all the series in the data bank which you have tagged .    You can tag all the 
series in a particular group using the TAG command available in the GROUP menu, or you can tag a 
subset of the series in the current group using the TAG command in the SERIES menu.

The set of tagged series is basically a temporary group.    You can manipulate the series in the tagged 
group using Dbank's TAGGED menu.

The tagged list box allows you to make single or multiple selections.    To select a single series, click on 
the tagged series using the mouse.    Shift+click or Shift+arrow key extends the selection from the 
previously selected series to the current series. Ctrl+click selects or de-selects a series in the list.

By default, Tagged Menu commands operate on all the series in the tagged list box.    However, if 
you select any item(s) in the tagged list box, theTagged Menu commands affect only the selected 
series.



File Open Command

The File Open command opens a Dbank data bank.    All the data banks (i.e., *.mdb files) in the current 
directory (irrespective of their MS-DOS file attribute) are shown in the file list box.    You can open a data 
bank using the keyboard or mouse.    If Dbank can open the data bank successfully, it will enable the 
Group and Series list boxes.    The Group list box contains all the groups in the current data bank, while 
the series list box contains all the series in the current group.

NOTE: you do not need to close the active data bank to open another data bank.    Simply double-click on 
the data bank you wish to open to switch to that data bank.

Shortcut Key: Ctrl+O, Enter; Spacebar.

Mouse Shortcut: Double-click on the data bank you wish to open.



File Close Command

File Close closes ALL the active data banks and removes the Group, Series and Tagged list boxes.

The File Close command is quite similar to Dbank's File Exit command (i.e., leave Dbank); however, the 
File Close command closes ALL data banks without returning you to Window's Program Manager.

Shortcut Key:    Ctrl+L.

Mouse Shortcut: (provided the active data bank is selected in the file list Box, and the mouse pointer is 
currently over the file list box) click the RIGHT mouse button.



File Query Command

File Query finds all the series in the selected data banks that satisfy your query.    The matched series are 
displayed in Dbank's BROWSE form, which allows you to COPY, DELETE, TAG, UNTAG, RENAME, 
EDIT, PLOT, and VIEW the series.    You can construct queries on the series titles ([Title]), the series 
names ([Name]), the frequency of the series ([Frequency]), and the "long-name" of the series ([Long 
Name]).

Any of these items can be combined into a single SQL query using the File Query SQL statement 
command.    For example, the SQL statement

[Title] LIKE "*BALANCE*" and [Frequency] = "Q" 

finds all the quarterly series in the selected data banks with the string "BALANCE" in their title.



File Tree Command

File Tree provides a visual outline of the data banks' current tree-structure, and replicates most of the 
functionality of Dbank's startup form.

Shortcut Key: Ctrl+E.



File Attribute Command

File Attribute makes the selected data bank either (a) read-only (CTRL+Y); or (b) read-write (CTRL+W).    
This command is used to create data banks that will ultimately be saved on a shared or network drive.



File Caption Command

File Caption allows you to attach a short (up to 255 character) description to the current data bank which 
is displayed whenever the user clicks on the data bank.



File Copy Command

File Copy copies a data bank.    The name of the new data bank cannot be the same as the name of the 
source.    You may select more than one data bank before invoking the File Copy command.

Shortcut Key: Ctrl+P.



File Delete Command

File Delete deletes a data bank(.mdb), and the data file(.fdb) with (optional) confirmation.    You may select
more than one data bank before invoking the File Delete command.

Shortcut Key: Ctrl+D.



File Dump Command

File Dump dumps the contents of a data bank (i.e., all the series and data) to an ASCII file structured in 
any one of the following supported formats:

(a) Dbank's FREE format;
(b) AREMOS ".TSD" ASCII file format;
(c) CITIBASE TAPE ASCII file format;
(d) TSP ASCII file format.



File Make Command

File Make creates a new, empty data bank(.mdb), and its data file(.fdb).

Shortcut Key: Ctrl+K.



File Memo Command

File Memo allows you to attach a lengthy (up to 32K) description to the current data bank.



File Move Command

File Move moves a data bank to another directory/disk.    File Move can also rename a data bank.    You 
can select more than one data bank before invoking the File Move command.

Shortcut Key:    Ctrl+V.



File ReMake Command

File ReMake updates (i.e., "ReMakes" or re-generates) all the series in the data bank that were previously
created using the "Series Make" command (see below).    Dbank allows you to re-generate series 
recursively, or non-recursively.    Under recursive ReMake,    Dbank performs a "spreadsheet style" 
recalculation of all the series in the data bank.    For example, if x = log(y), and y = abs(bal_paym),    
Dbank updates y BEFORE re-computing x.    With non-recursive ReMake,    Dbank computes x = log(y) 
without updating y.

File ReMake is often used soon after the data in the data bank are revised.    File ReMake obviates the 
need for users to invoke "Series Make" to allow for the updated data (a tedious process at best), and is a 
great time saver.



File Rename Command

File Rename renames the data bank(.mdb), and the data file(.fdb).      File Rename can also move a data 
bank to another directory or hard disk, and allows you to operate on more than one data bank.

Shortcut Key:    Ctrl+R.



File Repair Command

File Repair repairs a data bank (this can occur because of a power-out, or abnormal termination of 
Microsoft Windows(TM))    You can select more than one data bank before invoking the File Repair 
command.

Shortcut Key: Ctrl+I.



File Squeeze Command

File Squeeze recovers unused bytes from a data bank (caused by the deletion of series) by creating a 
new data bank containing the squeezed contents of the original data bank, and then copying the new data
bank over the old (i.e., unsqueezed data bank).    You can select more than one data bank before invoking
the File Squeeze command.

Shortcut Key: Ctrl+Z.



File Update Command

File Update updates an existing data bank to the latest Dbank format.    This command has no effect if the
data bank's structure is current.



File Add Data Command

File Add Data imports data into Dbank.

The data are added to the data bank with the same filename as the input file.    The data bank will be 
created if it does not exist.

ASCII input files can be organized in any one of Dbank's FREE, SERIES, or MATRIX formats.    They may
also be organized in the CITIBASE TAPE ASCII file format, and the AREMOS ".TSD" ASCII file format (Be
careful to ensure that the series names are less than nine (9) characters in length).

If you have a copy of Microsoft's EXCEL,    the File Add Data command allows you read data in a EXCEL 
spreadsheet.    Dbank will prompt you for the name of the spreadsheet to import.    You will need to 
indicate the spreadsheet cells you want to copy.

Dbank can also read GAUSS ".DHT" and ".FMT" 16/32 bit binary files directly.    Simply select the files to 
do so.

Select "File Add Data Manual Input" to manually type data into Dbank (or click on the "input icon" on 
Dbank's start up form).

Shortcut Key: CTRL+N



File Add Data from DOS-DBANK Command

This command converts a DOS-Dbank file to the WINDOWS-Dbank format. The data are added to a data
bank (which need not exist) with the same filename as the DOS-Dbank file.

This command is provided for downward compatibility with the character-based version of Dbank (a 
distant cousin of the Windows version).



File Utilities Command

The File Utilities command allows you to:

(a) create a character mode DOS session;
(b) import data from a DOS-DBANK data bank;
(c) invoke the Microsoft Windows(TM) CALCULATOR (CALC.EXE) program;
(d) invoke Microsoft Window's EXCEL program;
(e) turn-off automatic invocation of MS Excel whenever ACE/OLS is invoked;
(f) upgrade a Paradox Dbank data bank (earlier versions of Dbank used the

Borland Paradox Engine).



File Utilities Shell Command

File Utilities Shell creates a character mode DOS session.    Type EXIT to destroy the DOS session and 
return to Dbank.    Type CTRL-ESC to return to Dbank without destroying the DOS session.



File Utilities Calculator Command

File Utilities Calculator calls up Windows' CALCULATOR program.    CALC.EXE must be on the active 
path for this command to work.

Shortcut Key:    Ctrl+T.



File Utilities Excel Command

File Utilities Excel invokes Microsoft's EXCEL spreadsheet program.    EXCEL.EXE must be on the active 
path for this command to work.

Shortcut Key:    Ctrl+M.



File Print Form Command

File Print Form dumps Dbank's startup form to the active printer.

Shortcut key: Ctrl+F.



File Exit Command

File Exit ends the current Dbank session and closes all active data banks and any unclosed disk files.

Shortcut key: Ctrl+X.



Group Browse Command

Group Browse loads Dbank's BROWSE form with the all series in the selected groups.    The BROWSE 
form provides a tabular representation of a series' index records.    It also allows you to COPY, DELETE, 
TAG, UNTAG, RENAME, EDIT, PLOT and VIEW the series.

Shortcut key: (if the group list box has the focus) 'B' or 'b'.



Group Change Command

Group Change allows you to change to a particular group in the current data bank using the keyboard.

Shortcut key: (if the group list box has the focus) 'H' or 'h'.



Group Copy Command

Group Copy copies all the series in the selected groups (and their sub-groups) to another group or data 
bank.    The destination group and data bank need not exist.

To copy a series to another data bank, you must provide a fully qualified series name to the copy 
command prompt --    i.e., use the syntax Drive:\Path\Data bank[GroupName].    For example, to copy all 
the series in the group [FIRST] to another data bank, say EXTRACT, in a group called [PAPER.WHITE], 
you type EXTRACT[PAPER.WHITE].    To copy the current group to another group within the same data 
bank,    specify the destination group only -- e.g., [PAPER.WHITE]

Shortcut key: (if the group list box has the focus) 'C' or 'c'.



Group Delete Command

Group Delete deletes the selected groups from the data bank.    The groups must be empty (i.e., they 
cannot contain any series).

Shortcut key: (if the group list box has the focus) 'D' or 'd'.



Group Edit Command

Group Edit invokes Dbank's EDIT form for ALL the series in the selected groups (and associated sub-
groups).    Dbank's EDIT form allows you to edit series' index record.

NOTE: series with frequencies different from the FIRST series Dbank selected by Dbank to edit are 
automatically omitted from the edit matrix.

Shortcut key: (if the group list box has the focus) 'E' or 'e'.



Group Label Command

Group Label allows you to attach a short label/description ( < 256 characters) to a group.    You can edit 
existing group labels using this command.

Shortcut Key:    (if the group list box has the focus) 'A' or 'a'.



Group Make Command

Group Make creates a new group in the current data bank.    The new group belongs to the current group.

Shortcut Key:    (if the group list box has the focus) 'K' or 'k'.



Group Memo Command

Group Memo allows you to attach a lengthy description ( < 32K characters) to a group.    You can edit 
existing group memos using this command.

Shortcut key: F2.



Group Move Command

Group Move moves all the series in the selected groups (and their sub-groups) to another group or data 
bank.    The destination group need not exist.

Shortcut key: (if the group list box has the focus) 'V' or 'v'.



Group Query Command

Group Query finds all the series in the selected groups (and their sub-groups) that satisfy your query.    
The matched series are displayed in Dbank's BROWSE form, which allows you to COPY, DELETE, TAG, 
UNTAG, RENAME, EDIT, PLOT, and VIEW the series.    You can construct queries on the series titles 
([Title]), the series names ([Name]), the frequency of the series ([Frequency]), and the "long-name" of the 
series ([Long Name]).



Group ReMake Command

Group ReMake updates (i.e., re-generates) all the series in the selected groups (and their sub-groups) 
that were previously created using the "Series Make" command (see below).    Dbank allows you to 
regenerate series recursively, or non-recursively.    Under recursive ReMake,    Dbank performs a 
"spreadsheet style" recalculation of all the series in the selected groups.    For example, if x = log(y), and y
= abs(bal_paym),    Dbank updates y BEFORE re-computing x.    With non-recursive ReMake,    Dbank 
computes x = log(y) without updating y.

This command is often used immediately after the data bank is updated.    It obviates the need for users to
invoke "Series Make" to update their series to account for updated data.



Group Rename Command

Group Rename renames (one at a time) the selected groups .

Shortcut Key: (if the group list box has the focus) 'R' or 'r'.



Group Sort Command

Group Sort sorts the entries in the group list box by name.

Shortcut Key: F3.



Group Tag Command

Group Tag tags all the series in the selected groups (and their sub-groups).    Dbank places the series in 
the Tagged List box.    You can manipulate the tagged series using the Tagged menu.

Shortcut Key: (if the group list box has the focus) 'T' or 't'.

Mouse short cut:    select the group you wish to tag and then click on the RIGHT mouse button.



Group UnTag Command

Group UnTag untags all the series in the tagged list box that belong to the selected groups.

Shortcut Key: (if the group list box has the focus) 'U' or 'u'.



Group View Command

Group View loads the VIEW form with all the series in the selected groups (and their sub-groups). The 
VIEW form allows you to inspect the data stored in a series.

Shortcut Key: (if the group list box has the focus) 'W' or 'w'.



Group Xdelete Command

Group Xdelete deletes all of the series in the selected groups and their sub-groups and (optionally) the 
groups themselves.

Shortcut Key: (if the group list box has the focus) 'X' or 'x'.



Group Print Command

Group Print prints all the series in the selected groups and their sub-groups (including the data).

Shortcut Key: (if the group list box has the focus) 'P' or 'p'.



Group Print Index Command

Group Print Index prints the index record for all the series in the selected groups and their sub-groups.

Shortcut Key: {if the group list box has the focus} 'I' or 'i'.



Group Mosaic Time Plot Command

Group Mosaic Time Plot provides a mosaic time plot of all the series in the selected groups and their sub-
groups.

Shortcut Key:    (if the group list box has the focus) 'L' or 'l'.



Group Summary Statistics Command

Group Summary Statistics computes various summary statistics (e.g., mean, variance) for all the series in
the selected groups and their sub-groups.

Shortcut Key:    (if the group list box has the focus) 'M' or 'm'.



Series Add Data Command

Series Add Data reads series data stored in a file and adds the data to the current data bank.    The data 
can be organized in Dbank's "FREE" (*.FRE), "MATRIX" (*.MAT) or "SERIES" format; or it can be 
structured in the "CITIBASE TAPE ASCII TAPE" file format, or the "AREMOS .TSD" ASCII file format.    

Data may also be read directly from a Microsoft Excel spreadsheet (*.XLS).    You need access to a copy 
of EXCEL in order to read *.XLS files.

Dbank can import GAUSS ".DHT" and ".FMT" binary files directly (16/32 bit).

Shortcut Key:    (if the series list box has the focus) 'A' or 'a'.



Series Link Command

Series Link allows you to create "link" variables.    A link variable is a pointer to an existing set of 
observations in a data bank.    It is essentially another name for the same observations in the data bank.    
However, it is best understood as a pointer to the data of the series, not to the name of an existing series. 
This feature of Dbank enables you to maintain a single copy of the data in the data bank, but with many 
pointers to the same data.    Thus, changing the data (via an edit operation, for example) changes the 
data for all the series that point to those data.

A link variable may span across groups, but it cannot refer to a series in a different data bank.    Dbank 
automatically alters the pointers if you rename/move the series being pointed to.

Deleting a link variable does NOT delete the original series, and deleting a linked series does NOT delete 
the link variable(s).    However, if you squeeze the data bank, any link variables that point to a previously 
deleted series will NOT appear in the squeezed version of the data bank.

"Link Create" creates a link variable; "Link Show" shows all the link variables that exist for a particular 
variable; and "Link Convert to Ordinary Series" converts a link variable to a normal variable in the data 
bank.



Series Browse Command

Series Browse loads Dbank's BROWSE form, which provides a tabular representation of the index 
records of the selected series.    The BROWSE form allows you to perform various operations on 
individual series, including COPY, DELETE, TAG, UNTAG, RENAME, EDIT, PLOT, and VIEW.

Shortcut Key:    (if the series list box has the focus) 'B' or 'b'.



Series Copy Command

Series Copy copies the selected series to another series, group, or data bank.    To copy a series to 
another data bank, use the syntax Drive:\Path\FileName[GroupName]SeriesName.    For example, to 
copy the series BPASPV in the group [FIRST.BP] to another data bank, say EXTRACT, in a group called 
[PAPER.WHITE.A4], you type EXTRACT[PAPER.WHITE.A4]BPASPV when the Series Copy command 
prompts for the destination of the series.    To copy to another group within the same data bank, you 
specify just the destination group e.g., [PAPER.WHITE.A4].

Shortcut Key:    (if the series list box has the focus) 'C' or 'c'.



Series Delete Command

Series Delete deletes the selected series in the current group with (optional) confirmation before deletion.

Shortcut Key:    (if the series list box has the focus) 'D' or 'd'.



Series Convert Command

Series Convert allows you to change the frequency of a series.

You can convert a dated series to:

(1) the null frequency;
(2) a lower frequency (e.g., from monthly to annual data);
(3) an undated series with no frequency.

You can convert a series with a null frequency to any dated frequency.

Dbank supports seven conversion methods: AVERAGE, SUM, LAST, FIRST, MAXIMUM, MID-POINT, and
MINIMUM

Shortcut Key: none



Series Edit Command

Series Edit invokes the EDIT form, which allows you to change the selected series' index records and 
data. 

Shortcut Key:    (if the series list box has the focus) 'E' or 'e'.



Series Input Command

Series Input invokes the INPUT form, which allows you manually input data into a data bank.

Shortcut Key:    (if the series list box has the focus) 'N' or 'n'.



Series Make Command

Series Make creates a new series from existing series in the data bank.    Series Make accepts an 
algebraic expression involving series or numbers and computes the result.    Make recognizes the 
following operators:

 ^ (power), - (unary negation), * (multiplication), / (division), \ (integer division), % (Modulo arithmetic), %# 
(Modulo arithmetic without integer truncation), + (addition), - (subtraction),    = (equal to), <> (inequality), <
(less than), > (greater than), <= (less than or equal to), >= (greater than or equal to), ! (Bitwise unary 
NOT), & (Bitwise AND), | (Bitwise OR), ^| (Bitwise XOR), == (Bitwise EQV), => (Bitwise IMP)

and the following functions:

Abs (Absolute) Log (log to base e), Log10 (log to base 10), Sqr, Fix (towards 0), Int (towards left), Ceil 
(ceiling), Sgn, Rnd (stochastic random number), Rndfix (deterministic random number), Deg (Degree), 
Rad (Radian), Exp (exponential), ExpSmooth (exponential smoother), Smooth (Friedman's super-
smoother), Mean, Median, Sd (standard deviation), Demean (removes the mean), Var (Variance), Acf 
(correlogram), Pdf (probability density function), Lead (lead a series one period), Lag (lag a series one 
period), Ma (centered moving average), Diff (difference), MDiff (multiple difference), SigDigits (significant 
digits of a number), Round, Reverse (reverse the vector), Csum (cumulative sum), Cprod (cumulative 
product), Sort, Permute (shuffle the vector), Index, Rank, Period (periodicity indicator), Ismiss (flags 
missing values), Pack (remove missing values), Trim (trim a vector), Select (randomly select a subset of 
the vector), SelectIndex (generates a vector of selection indices),    Sin, Cos, Tan, Sec, CoSec, CoTan, 
Asin, Acos, Atan, Asec, Acosec, Acotan, Sinh, Cosh, Tanh, Sech, Cosech, Cotanh, Asinh, Acosh, Atanh, 
Asech, Acosech, and Acotanh.

With the exception of ACF, LEAD, LAG, ROUND, DIFF, MDIFF, MA, SIGDIGITS, SELECT, 
SELECTINDEX, TRIM, and the EXPSMOOTH functions, all of the listed functions accept a single 
argument.    The argument may be a single series or the result of any algebraic operation(s) on any 
series.    

The syntax for the ACF, LEAD, LAG, ROUND, DIFF, MDIFF, MA, SIGDIGITS, SELECT, SELECTINDEX, 
TRIM, and EXPSMOOTH functions is 

fn(arg1, arg2, arg3, arg4...);

that is, they accept more than one argument.

In the case of LEAD/LAG, arg2 is the number of periods to LEAD/LAG the series (i.e., arg1). DIFF(x,k) = 
x(t)-x(t-k), and MDIFF(x,k) applies DIFF(x,1) to x(t) k-1    times.    MA(x,k) computes a kth period 
(centered) moving average of x.    In ROUND, arg2 is the number of decimals to round arg1 to. If k is 
negative, ROUND rounds arg1 to the (-k+1)st digit to the left of the decimal point.    For the EXPSMOOTH
function, arg2 can be any real number between 0 and 1 (inclusive).    For ACF, arg2 is the maximum auto-
correlation lag.    SIGDIGITS(x,k) returns the number of required (k) significant digits of x.    If k is negative,
SIGDIGITS(x,k) preserves any integer part of x.    For TRIM, arg2 is the number of data points to remove 
from the beginning of the vector, and arg3 is the number of data points to delete from the end of the 
vector.    For SELECT(x, arg2), arg2 is the number of elements of    x to randomly select.    And for 
SELECTINDEX(x, arg2), arg2 is the number of indices (pointing to elements of x) to select.

In the case of LEAD/LAG, you may use the syntax    x = lag(y, -n TO m) to easily create multiple leads and
lags of a particular variable.    The previous syntax will create (m+n+1) variables:    n leads (i.e., -n, -(n-1), -



(n-2), -1), y itself (i.e. lag(y,0)), and m lags of y (i.e., 1, 2, 3, 4, ..., m).    If the lag index is negative, the 
name of the new variable will be constructed by appending "nj" to the variable name, where j is the 
amount of the lead.    Thus, lag(y,-1) will be saved as "yn1".    If the lag index is positive, the name of the 
resulting variable will be constructed by appending "pj" to the variable name, where j is the amount of the 
lag.

Arg2 can be omitted when using some of these functions.    Arg2 defaults to one (1) in the 
ACF/LEAD/LAG/DIFF/MDIFF functions and to zero (0) in ROUND.

Functions can be nested to any depth (memory permitting).    For example, if x and y are series in the 
current data bank, then the following algebraic expression is allowed:

lead(exp(lag(abs(log(x+y)^4),5)),10)

Note that the result of the operation will be a series of the same frequency as series    x    and    y.    The 
length (or sample period) of the new series will be the maximum sample period over which both x and y 
exist. Also, the symbol PI# has been defined to      (the mathematical constant) in Series Make.

Make accepts fully qualified series names (i.e., data_bank[group]ser_name).    However, if fully qualified 
names appear on the right-hand side of the equation, they MUST be enclosed in double quotes (" ").      
Note that the data bank on the left-hand side of the equation need not exist.

Lastly, Make accepts more than one algebraic expression an a single line.    Separate each expression 
using your current "list separator".    Thus,    if your list separator is "," (i.e., comma), typing

a1 = ln(bpaspv), a2 = exp(bpaspv)

in Make's input box creates two series, a1 and a2.

Operator precedence:    arithmetic operators are evaluated first, comparison operators are evaluated 
next, and logical operators are evaluated last.    Within individual categories, operators are evaluated in 
the following order of precedence:

Arithmetic Comparison Logical

Power (^) Equality (=) Not (!)
Negation (-) Inequality (<>) And (&)
Multiplication and division (*, /) Less than (<) Or (|)
Integer division (\) Greater than (>) Xor (^|)
Modulo arithmetic (%, %#) Less than or Equal to (<=) Eqv (==)
Addition and subtraction (+, -) Greater than or Equal to (>=) Imp (=>)

All comparison operators have equal precedence; thus they are evaluated in the left-to-right order in 
which they appear in the expression.

When multiplication and division occur together in an expression, each operation is evaluated as it occurs
from left to right.    Likewise, when addition and subtraction occur together in an expression, each 
operation is evaluated in order of appearance from left to right.



You can override the operator precedence table by using parentheses.

Note: -1 is true in Dbank; 0 represents false

Shortcut Key: (if the series list box has the focus) 'K' or 'k'.



Series Move Command

Series Move moves the selected series to another group and/or data bank.    Dbank will prompt you for 
the name of the new group.    The destination group need not exist.

Shortcut Key: (if the series list box has the focus) 'V' or 'v'.



Series Memo Command

Series Memo allows you to attach a lengthy description ( < 32K characters) to a series.    You can edit 
existing series memos using this command.

Shortcut Key: F4



Series Probability Density Estimate Command

Series Probability Density Estimate estimates the probability density of a single series and plots the result
using Dbank's XYPLOT form.

Shortcut Key: (if the series list box has the focus) 'Y' or 'y'.



Series ReMake Command

Series ReMake updates (i.e., "ReMakes" or re-generates) all the selected series in the current group 
which were previously created using the "Series Make" command.    Dbank allows you to regenerate 
series recursively, or non-recursively.    Under recursive ReMake,    Dbank performs a "spreadsheet style" 
recalculation of all the series in the selected groups.    For example, if x = log(y), and y = abs(bal_paym),    
Dbank re-computes y BEFORE re-computing x.    With non-recursive ReMake,    Dbank computes x = 
log(y) without updating y.

This command is often used immediately after the data bank is updated.    It obviates the need for users to
invoke "Series Make" to update their derived series to account for updated data.



Series Rename Command

Series Rename renames (one at a time) the selected series.

Shortcut Key:    (if the series list box has the focus) 'R' or 'r'.



Series Scatter Plot Command

Series Scatter Plot produces an XY plot of the last two selected series in the series list box.

Shortcut Key:    (if the series list box has the focus) 'O' or 'o'.



Series Sort Command

Series Sort sorts the entries in the series list box by any one of the following criteria:

(a) creation date
(b) series name [F5]
(c) frequency
(d) revision date

Shortcut Key:    Series Name, F5.



Series Time Plot Command

Series Time Plot plots the selected series against time.

Shortcut Key:    (if the series list box has the focus) 'L' or 'l'.



Series Tag Command

Series Tag tags the selected series and places a copy of the fully qualified name of the series in the 
tagged list box.    Dbank also appends a superscript "1" to the series name in the series list box when you 
tag a series to provide you with an easy way to identify all the tagged series in the current group.

You can tag any series more than once.    When you do so, that series will be moved to the end of the 
tagged list box.    This feature is provided because Dbank's scatter plot form always uses the last two 
series in the tagged list box.

Shortcut Key: (if the series list box has the focus): 'T' or 't'.

Mouse short cut:    click the RIGHT mouse button, or double-click on the series you wish to tag.



Series View Command

Series View loads Dbank's View form with the selected series.    Dbank's View form allows you to inspect 
the data stored in a series.

Shortcut Key: (if the series list box has the focus): 'W' or 'w'.



Series UnTag Command

Series UnTag untags the selected series, removing their entries from the Tagged list box.

Shortcut Key: (if the series list box has the focus): 'U' or 'u'.



Series Print Command

Series Print prints the selected series (and their data).

Shortcut Key:    (if the series list box has the focus) 'P' or 'p'.



Series Print Index Command

Series Print Index prints the index record for the selected series.

Shortcut Key: (if the series list box has the focus): 'I' or 'i'.



Series Summary Statistics Command

Series Summary Statistics computes various summary statistics (e.g., mean, variance, etc.) for the series 
you have selected in the series list box.

Shortcut Key: (if the series list box has the focus): 'M' or 'm'.



Tagged Browse Command

Tagged Browse loads Dbank's BROWSE form with the series in the tagged list box. The BROWSE form 
has a SERIES menu, from which you can COPY, DELETE, MOVE, EDIT, RENAME, TAG, UNTAG, 
PRINT, and VIEW the series in the tagged group.

Shortcut Key:    (if the tagged list box has the focus) 'B', or 'b'.



Tagged Copy Command

Tagged Copy copies the tagged series to another data bank/group.    To copy to another data bank, use 
the syntax Drive:\Path\File[GroupName].    Thus to copy all the series in the tagged series to another data 
bank, say EXTRACT, in a group called [PAPER], you type EXTRACT[PAPER] when the Tagged Copy 
command prompts you for the destination of    the series.    To copy to another group within the same data 
bank, specify just the destination group -- e.g., [PAPER].

Shortcut key: (if the tagged list box has the focus) 'C' or 'c'.



Tagged Delete Command

Tagged Delete deletes the tagged series.

Shortcut key: (if the tagged list box has the focus) 'D' or 'd'.



Tagged Edit Command

Tagged Edit invokes Dbank's EDIT form, which allows you to modify the tagged series' index record and 
data.

Shortcut Key:    (if the tagged list box has the focus) 'E' or 'e'.



Tagged Move Command

Tagged Moves moves the tagged series to another group.    The destination group need not exist.

Shortcut Key: (if the tagged list box has the focus) 'V' or 'v'.



Tagged ReMake Command

Tagged ReMake updates (i.e., regenerates) all the series in the tagged list box which were previously 
created using the "Series Make" command (see above).    Dbank allows you to update series recursively, 
or non-recursively.    Under recursive ReMake,    Dbank performs a "spreadsheet style" recalculation of all 
the series in the selected groups.    For example, if    x = log(y), and    y = abs(bal_paym), Dbank re-
computes    y    BEFORE re-computing    x.    With non-recursive ReMake,    Dbank computes x = log(y) 
without updating y.



Tagged Rename Command

Tagged Rename renames (one at a time) the series in the tagged list box.

Shortcut Key: (if the tagged list box has the focus) 'R' or 'r'.



Tagged Sort Command

Tagged Sort sorts the items in the tagged list box.    You can sort the items by any one of the following 
criteria:

(a) Creation date;
(b) Fully qualified name;[F6]
(c) Frequency;
(d) Revision data;



Tagged UnTag Command

Tagged UnTag untags all the series in the Tagged list box, and removes the tagged list box.

Shortcut Key: (if the tagged list box has the focus) 'U' or 'u'.

Mouse short cut:    click on the RIGHT mouse button.



Tagged View Command

Tagged View invokes Dbank's View form with the tagged series.    Dbank's View form is used to inspect 
data stored in the series.

Shortcut Key: (if the tagged list box has the focus) 'W' or 'w'.



Tagged Print Command

Tagged Print prints all the series in the tagged list box (and their data).

Shortcut Key: (if the tagged list box has the focus) 'P' or 'p'.



Tagged Print Index Command

Tagged Print Index prints the index record of the series in the tagged list box.

Shortcut Key: (if the tagged list box has the focus) 'I' or 'i'.



Tagged ACE Command

Tagged ACE applies the ACE algorithm on the series in the tagged list box.

ACE was published by Leo Breiman and Jerome Friedman on pp. 580-619 of the September, 1985 issue 
(Volume 80) of the Journal of the American Statistical Association: Estimating Optimal Transformations for
Multiple Regression and Correlation (with discussion).    Tagged ACE implements this procedure for all the
series in the tagged list box.

Shortcut Key: (if the tagged list box has the focus) 'A' or 'a'. 



Tagged Export Command

Tagged Export invokes Dbank's DUMP/EXPORT form, which allows you to copy the tagged series to an 
ASCII file or an Excel spreadsheet.    The output file can be structured in any one of the supported formats
(i.e., AREMOS, BMDP, FREE, TSP, GAUSS, LIMDEP, MATRIX, SAS, SERIES, SST, RATS, LOTUS, 
EXCEL and QUATTRO).

Before you can copy a series, you must indicate the desired format (using the Format menu), the sample 
period for the copy command (click on the BOUNDS button), and the output file (use the File Open or File
Append command).

Shortcut key: (if the tagged list box has the focus) 'X' or 'x'.



Tagged Mosaic Single Y vs Xs Plot Command

Tagged Mosaic Single Y vs Xs Plot produces a mosaic scatter plot of the first series in the tagged list box 
against the remaining series in the tagged list box (taken one at a time).



Tagged Mosaic (X,Y) Pairs Plot Command

Tagged Mosaic (X,Y) Pairs Plot produces a mosaic (X,Y) pairs plot of the series in the tagged list box.



Tagged Mosaic Time Plot Command

Tagged Mosaic Time Plot produces a mosaic time plot of the series in the tagged list box.



Tagged Time Plot Command

Tagged Time Plot provides a time plot of the first 14 tagged series in the tagged list box.

Shortcut Key: (if the tagged list box has the focus) 'L' or 'l'.



Tagged Scatter Plot Command

Tagged Scatter Plot loads the XY Plot form, which displays an XY plot of the LAST two series in the 
tagged list box.

Shortcut Key: (if the tagged list box has the focus) 'E' or 'e'.



Tagged OLS-IV-2SLS Regression Command

Tagged OLS-IV-2SLS Regression loads Dbank's regression module using the selected variables in the 
tagged list box.    Dbank supports Ordinary Least Squares (OLS) and Instrumental Variable Estimation (IV,
2SLS).

Shortcut Key: (if the tagged list box has the focus) '2' 



Tagged Summary Statistics Command

Tagged Summary Statistics computes various summary statistics (e.g., mean, variance) for all the series 
in the tagged list box.

Shortcut Key:    (if the tagged list box has the focus) 'M' or 'm'.



Export File Menu - Open

Use the Export File|Open command to specify the name of the output file for the tagged series.

You do not need to specify a file extension; Dbank will append an extension to the filename depending on
the current output format.

Note: Dbank disables the OPEN command until you specify the output format.



Export File Menu - Close

The Export File|Close command closes the current output file.



Export File Menu - Peek

The Export File|Peek command allows you to peek at the output file created by the EXPORT form.    Only 
the first 15K of the file is displayed.



Export File Menu - Missing Value

The Export File|Missing Value command allows you to change Dbank's default missing value code on 
export.    The missing value code is the number which Dbank places in the output file to flag that an 
observation is missing.

You do not need to specify a missing value code.    By default,    Dbank uses a period '.' for a missing 
value (provided the destination program accepts a period as a missing value indicator).    If the destination
program does not accept a period,    Dbank uses 'NaN' , which stands for 'Not a Number'



Export File Menu - Verbose

The Export File|Verbose command allows you to monitor the progress of the copy command.    When 
VERBOSE is active,    DBANK displays the name of the series it is processing.



Export File Menu - Shell

The Export File|Shell command creates a character mode DOS session.    Type EXIT or CTRL-ESC to 
return to Dbank.



Export File Menu - Exit

The Export File|Exit command closes the EXPORT form.



Export File Menu 

Use the Export File|Open command to specify the name of the output file to which Dbank will copy the 
tagged series.    Do not provide a file extension when using the Open command; Dbank will append an 
appropriate extension to the filename that depends on the current output format.    Note that Dbank 
disables the OPEN command until you have chosen an output format.

The Export File|Close command closes the output file.

Use the Export File|Missing Value command to specify the missing value code for output.    This is the 
number which Dbank uses to flag a missing value in the output file.

You need not specify a missing value code.    By default,    Dbank uses a period    '.'    for the missing value 
(provided the destination program accepts a period for its missing value indicator).    If the destination 
program does not accept a period,    Dbank uses    'NaN' , which stands for 'Not a Number'.

The Export File|Verbose command allows you to monitor the progress of the copy command.    When 
VERBOSE is active,    DBANK will display the name of the series it is processing.

The Export File|Shell command creates a character mode DOS session.    Type EXIT or CTRL-ESC to 
return to Dbank.

The Export File|Exit command closes the EXPORT form.



Export Convert Menu

The CONVERT menu controls the manner in which Dbank converts time series to lower frequencies.    By
default, Dbank will automatically convert a time series to a lower frequency using the conversion method 
saved in the series index record.

The OFF command suppresses automatic conversion (automatic conversion is the default).    In this case,
Dbank attempts to copy each tagged series as is.    However,    please note that this is possible only if the 
tagged series have the same frequency as the current global frequency (as specified with the bounds 
form) and the output format does not require that the data have the same number of observations.

The AUTOMATIC command allows you to override the default conversion method specified in the series' 
index record.    You may choose any one of the five conversion methods available:    (a) FIRST;    (b) LAST;
(c) SUM; (d) AVERAGE; and (e) MID-POINT.      The conversion method you select is applied to all the 
series copied to the output file.

The PROMPT command instructs Dbank to prompt you for a conversion method before copying the 
series.    It supports two modes:

(a) For all series:    In this case, Dbank will prompt you for a conversion method for each of the series to 
be copied, even if a conversion method has been specified for the index record; and,

(b) Only if necessary.    In this case,    Dbank will prompt you for a conversion method only if a conversion 
method has NOT been specified in the index record.



Export Convert Menu - OFF

The CONVERT menu controls the manner in which Dbank converts time series to lower frequencies 
during the copy process.    By default, Dbank automatically converts a time series to a lower frequency 
using the internal conversion method indicated in the series' index record.

The OFF command suppresses automatic conversion (the default), forcing Dbank to copy the series as is
(assuming this is possible).



Export Convert Menu - Automatic

The CONVERT menu controls the manner in which Dbank converts time series to lower frequencies 
during the copy process.    By default, Dbank automatically converts a time series to a lower frequency 
using the internal conversion method indicated in the series' index record.

The AUTOMATIC command allows you to override the default conversion method.    You may select any 
one of the five conversion methods available:    (a) FIRST;    (b) LAST; (c) SUM; (d) AVERAGE; and (e) 
MID-POINT.    The conversion method you select is applied to all the series that will be copied to the 
output file.



Export Convert Menu - Prompt

The CONVERT menu controls the manner in which Dbank converts time series to lower frequencies 
during the export process.    By default, Dbank automatically converts a time series using the internal 
conversion method indicated in the series' index record.

The PROMPT command instructs Dbank to prompt you for a conversion method before it copies a series 
to the output file.    It supports two modes:

(a) For all series:    In this case,    Dbank will prompt you for a conversion method, even if an internal 
conversion method exists in the series' index record; and,

(b) Only if necessary.    In this case,    Dbank will prompt you for a conversion method only if an internal 
conversion method has not been specified in the index record.



Export Format Menu

This menu controls Dbank's output format.    Select the desired format.      Note that DDE to Excel initiates 
a "Dynamic Data Exchange" between Microsoft's Excel spreadsheet and Dbank.    You need access to 
Excel for this feature to work.



Export Filter Menu

Dbank can filter a variable according to the value of another series (called the filter variable).    If    the filter
mode is set to inclusive, Dbank copies the data in a series only if the corresponding observation in the 
filter variable is EQUAL to the current filter (e.g. '1').    However, when the filter mode is exclusive, Dbank 
will EXCLUDE the data point if    the corresponding observation in the filter variable is equal to the filter 
value.

The FILTER command is particularly useful for cross-sectional data, where it is often necessary to extract 
a subset of a series depending on the value of another series.

Use the    "Specify Filter Variable..."    command is to specify the name of the filter variable.    Although filter
variable does not have to be in the same data bank, it must have the same frequency as the current 
global frequency.

The OFF/ON command allows you to temporarily switch the filter variable on/off.

The "Value" command allows you to specify the filter value.    For example, if the filter value is set to 1, 
then Dbank will copy an observation in the tagged series only if the corresponding observation in filter 
variable is equal to 1.    The filter variable may be set to '.' -- i.e., Dbank's missing value code.      Note that 
the VALUE command implies that the same variable can store more than one filter.    The same variable 
can therefore extract different observations depending on the filter value. 



Export Filter Menu - Inclusive Mode

Dbank can filter a series according to the value of another series (called the filter variable).    This 
command is particularly useful for cross-sectional data, where it is often necessary to extract a subset of 
a series depending on the value of another series.    When the filter mode is inclusive, Dbank copies data 
in a series only if the corresponding observation in the filter variable is EQUAL to the current filter value 
(e.g. '1').



Export Filter Menu - Exclusive Mode

Dbank can filter a series according to the value of another series (called the filter variable).    This 
command is particularly useful for cross-sectional data, where it is often necessary to extract a subset of 
a series depending on the value of another series.    When the filter mode is exclusive, Dbank copies data 
in a series only if the corresponding observation in the filter variable is NOT equal to the current filter 
value (e.g. '1').



Export Filter Menu - Filter Variable

Dbank can filter a series according to the value of another series (called the filter variable).    This 
command is particularly useful for cross-sectional data, where it is often necessary to extract a subset of 
a series depending on the value of another series.    

Use the "Specify Filter Variable..." menu item to specify the name of the filter variable.    Although filter 
variable does not have to be in the same data bank, it must have the same frequency as the current 
global frequency.



Export Filter Menu - ON/OFF

Dbank can filter a series according to the value of another series (called the filter variable).    This 
command is particularly useful for cross-sectional data, for which it is often necessary to extract a subset 
of a series depending on the value of another series.    

The OFF/ON command allows you to temporarily switch filter on/off.



Export Filter Menu - Value

Dbank can filter a series according to the value of another series (called the filter variable).    This 
command is particularly useful for cross-sectional data, for which it is often necessary to extract a subset 
of a series depending on the value of another series.    

The VALUE command allows you to specify the filter value.    For example, if the filter value is 1, then 
Dbank will copy an observation in the tagged series only if the corresponding observation in filter variable 
is equal to 1.    The filter variable may be set to '.' -- i.e., Dbank's missing value code.    Note that the filter 
value must be set to a number which exists in the current filter variable.

The VALUE command allows you to have more than one filter value in the same filter variable.    The 
same filter variable can therefore extract different observations depending on the current setting of filter 
value. 



Export "Do It" Button

Press the "Do It!" button of the EXPORT form when you are ready to copy the series to the output file.

Important:    Dbank disables the "Do It!" button until all of the following parameters are specified:

(a) the sample period;
(b) the output format; and
(c) the name of the output file.



BOUNDS Button Form

Before you can copy a series to the output file, you must specify the sample period for the copy 
command.    The BOUNDS button of the EXPORT form allows you to do this.      Pressing the BOUNDS 
button brings up the BOUNDS form.

The FREQ menu allows you to specify the frequency of the sample period [i.e.,    ANNUAL, HALF-
YEARLY, QUARTERLY, MONTHLY, WEEKLY, DAILY (5,6,7 day cycle), or NONE].    Fill in the text boxes 
with the required start date and end date.

For weekly and daily data, you need to specify the first day, month and year, and the last day, month and 
year.

For half-annual, quarterly, and monthly data you need to specify the first year and the first period (i.e.,    
the first half year for half-yearly data;    the first month for monthly data, and the first quarter for quarterly 
data), and the last year and period.

For annual data, you need only specify the first and last year.      This is also the case for data stored with 
no frequency (such as cross-sectional data).    The first observation would have a start date of    '1'.    The 
last observation would have an end date of 'N', where N is the number of observations in the series.

The CHECK button is for checking your entry before pressing the OK button.    The OK button processes 
the BOUNDS.

The CANCEL button removes the BOUNDS form without changing the current sample.



Group List Box, Series List Box, Tagged List Box

Group List Box:    contains all the groups in the open data bank.
Series List Box: contains all series in the current group.    
Tagged List Box: contains all the series that the user has tagged.

You can move through the list boxes using the keyboard or the mouse.



Data Bank Directory

The data bank directory allows you to select a series within the current data bank.    You can select a 
series using the keyboard or the mouse.    Double click on either the group list box or the series list box to 
select the series.    Press the escape key to exit without selecting a series.



Export Tagged Menu

The "Tagged" menu of the Export form allows you to change the series in the tagged list box of the Export
form.    You can add and delete series from the tagged list box.    Use the "Add Variables..." menu item to 
add a series to the tagged list box.    The "Remove Variables" menu item deletes series from the tagged 
list box.    Lastly, the "View" menu item allows you to inspect the data associated with the series in the 
Export tagged list box.



Export Tagged Menu - Add Variables

The "Tagged" menu allows you to change the series in the tagged list box of the Export form.    Use the 
"Add Variables..." menu item to add a series to the tagged list box



Export Tagged Menu - Remove Variables

The "Tagged" menu allows you to change the series in the tagged list box of the Export form.    The 
"Remove Variables" menu item deletes series from the tagged list box.



Export Tagged Menu - View

The "Tagged" menu allows you to change the series in the tagged list box of the Export form.    You can 
also view the data associated with the series in the tagged list box.    Use the "View" menu item to do so.



Copying your Data to an Output file

Before you can copy the tagged series to an output file, you must:.

(1)    Select an output format by clicking on the FORMAT menu.

(2) Specify an output file by clicking on the FILE menu, and then selecting Open File.

(3) Specify the range of observations to copy by clicking on the BOUNDS button.

Once you have completed these steps,    Dbank will enable the "Do It!" button.    Click the "Do It" button to 
begin exporting the tagged series.



Reading data into DBANK -- General Information

Dbank can process five (5) types of ASCII data files: "FREE" format, "SERIES" format, "MATRIX" format, 
"AREMOS" format, and "CITIBASE (TAPE)" format.    The default input format is FREE.    If you have a 
copy of Microsoft's EXCEL spreadsheet,    Dbank can also read data stored in an EXCEL spreadsheet.    
GAUSS binary data files (".DHT" and ".FMT", 16/32 bit) can also be read directly into Dbank.

Dbank's SETUP program installs examples of each of these ASCII files on your hard disk (they are stored
in the same directory that you installed Dbank).    The file called EXAMPLE.FRE is organized in Dbank's 
FREE format. Two other files, EXAMPLE.SER and EXAMPLE.MAT, are examples of Dbank's SERIES 
and MATRIX input formats (respectively).    You can use these files to learn how to create data banks and 
manage data.

Input files are processed by the " Add Data..." command which appears in both the File and Series menus
of Dbank's startup (or main) form.    If you invoke the "Add Data..."    command from the Series menu, 
Dbank will add the data stored in the ASCII file to the data bank you have opened.    However, if you 
invoke the command from the File menu, Dbank adds the data to a data bank with the same filename as 
the input file (Dbank will create the data bank if necessary).

NOTE: you can interrupt the reading of ASCII input files at any time by pressing CTRL+BREAK or 
CTRL+C

1. FREE format (default extension: .FRE)

To read your data into Dbank using Dbank's FREE format you need to create an ASCII file that contains, 
for each series,    the following information:

1. [group name{.sub_group{.sub_group}}...]Name Obs Freq    F_year    F_period    F_day    Con_Code Precision Long_Name
2. Series Titlethis is where you put the title of the series
3. Data Values

where:

1. '[group_name{.sub_group{.sub_group}}...]Name' is the identifier of the series.    For example, 
[CITY.NY]BPB is a legal Dbank name.    BPB is the name of the series and it belongs to the sub-group NY
in the group called CITY.    Note that group, sub-group, and series names cannot be longer than 8 
characters.    Also, fully qualified group names must be delimited by left and right brackets (i.e., [ ])

A group (or sub-group) does not need to exist to add data to a data bank; Dbank will automatically create 
the group during the reading process.

2. 'Obs' is the number of observations in the series

3. 'Freq' is a one-character code representing the frequency or periodicity of the series.    Data with 
ANNUAL(A), HALF-YEARLY(H), QUARTERLY(Q), MONTHLY(M), WEEKLY(W), DAILY - 7-day week (D),
DAILY - 6-day week (S), DAILY - 5-day week (F),    or a NULL (N) frequency can be saved in a Dbank 
data bank.    The    NULL    frequency is most appropriate for cross-sectional data.

4. 'F_year' is the first year of the data.      Use 1 for data with a NULL frequency.



'F_period' is the first period of the data.    For HALF-YEARLY data, F-period can be set to 1 or 2; 
for QUARTERLY use 1, 2, 3 or 4; for MONTHLY, WEEKLY, and DAILY data use any integer in the range 
from 1 and 12 (inclusive), and for data with NULL frequency, use 0.

'F_day' is the first day of the data (use the appropriate day of the month for WEEKLY and DAILY 
data; 0 for other frequencies).

5. 'Con-code' is the conversion method Dbank should apply to the series when converting the data 
to a lower frequency (e.g., from WEEKLY to ANNUAL).    Dbank currently supports 5 conversion methods: 
(a) AVERAGE; (b) SUM; (c) FIRST; (d) LAST; and (e) MID-POINT.      You may also specify    NONE    to 
prevent conversion.    Only the first letter of the conversion method need be specified in the input file.

6 'Precision' is the precision with which Dbank will save the data in the data bank.      Dbank can 
save data in SINGLE or DOUBLE precision.    Single precision requires four (4) bytes per number; double 
precision requires eight (8).    Use single precision to minimize the size of your data bank.    Only the first 
letter of the precision need be specified.

7. 'Data' is the actual data of the series. The amount of data Dbank expects to read is determined 
by the number of observations specified in step 2 above.    Use as many records (or lines) as you need to 
list all the data.    The input format is free.

8. 'Long_Name' (optional) is the long-name of the series (up to 30 characters).    Use this argument 
to provide a more descriptive name for a series.    Note that Dbank does not allow you to locate a series 
according by its long-name.

Note that the input file can contain any number of series (of any frequency and precision).

Dbank supports missing values on input.    The missing value code is a period (i.e., '.').    You can change 
the missing-value code to a numeric value by including the following command in the input file:

MVAL    'your own missing value (e.g., -999).'

For example,

MVAL    -999

sets the missing value to -999.

Dbank will not use -999    when it actually saves the data in the file.    Dbank stores missing values using a
special missing value code. On output, missing values are indicated by    'NaN'    (i.e., Not a Number)    or   
a    period ('.'), provided the destination program supports it.

The following lines show the correct input format for a cross-sectional (Freq = N) series with 10 
observations:

[DEBT]DEBTLXL      10          N          1        0        0    N    S    DEBT_STOCK_RATIO



debt-stock to exports ratio
0.871850014 . 1.08260000 1.32647002 0.68683999
0.91070997 1.06666005 1.31024003 1.91513002 1.51312006

Dbank will store the series    DEBTLXL    in the group    DEBT    using SINGLE precision. Its title will be 
'debt-stock to exports ratio'.    The series long-name is DEBT_STOCK_RATIO.    As DEBTLXL is cross-
sectional data, its frequency is set to N (for 'NULL'), the first period is '1', and the conversion method is set
to NONE.    Note that the second observation is missing in the above example.

This is the correct format for a quarterly series with 58 observations:

[FIRST.US.Q]BPASPV            58    Q          1976        1    0    A    D
BAL OF P'MENT:U.S.PRIVATE ASSETS_ NET(MIL$_S.A.)
 -10838.00 -9207.00 -8782.00 -15671.00

    284.00 -11273.00 -5408.00 -14320.00
-14397.00 -4597.00 -8424.00 -29784.00
-3535.00 -15129.00 -28069.00 -12718.00
-8240.00 -24236.00 -17031.00 -23295.00
-17429.00 -19886.00 -15953.00 -47410.00
-31658.00 -38825.00 -22784.00 -20129.00
-23765.00 -297.00 -9278.00 -16562.00
-1037.00 -20168.00 15974.00 -17221.00
-3119.00 838.00 -3357.00 -15408.00
-13137.00 -22608.00 -22851.00 -31724.00
11459.00 -25815.00 -25581.00 -33156.00
4661.00 -19048.00 -36960.00 -31885.00
-29821.00 11017.00 -38654.00 -45496.00
36713.00 -26190.00

Dbank will save    BPASPV    in the sub-group called    Q    which belongs to the sub-group US with parent 
FIRST.    The series will be saved in double precision.    The series starts in the first quarter of    1976.    
Dbank will convert the series to a lower frequency using the average of the appropriate quarters.    The 
series will not have a long-name.

If the input file contains series that already exist in the destination data bank,    Dbank will, by default, 
overwrite the contents of the series with the data in your input file.    If you wish to simply update the data 
in an existing series without destroying the non-overlapping data in the data bank,    switch to Dbank's 
update mode by inserting the command 

UPDATE ON

in the input file.    You can switch off update mode with the command 

UPDATE OFF

The update command is allowed only in FREE format input files



2.    SERIES format (default extension:    .SER)

Series format is similar to FREE format but much simpler.      You do not need to specify anything except 
the name of the series.    The name of the series may optionally be preceded by a group specification.

The following lines show the correct format for the BPASPV series using the SERIES format: 

[FIRST]BPASPV
-10838.00  -9207.00 -8782.00 -15671.00
284.00 -11273.00 -5408.00 -14320.00
-14397.00 -4597.00 -8424.00 -29784.00
-3535.00 -15129.00 -28069.00 -12718.00
-8240.00 -24236.00 -17031.00 -23295.00
-17429.00 -19886.00 -15953.00 -47410.00
-31658.00 -38825.00 -22784.00 -20129.00
-23765.00 -297.00 -9278.00 -16562.00
-1037.00 -20168.00 15974.00 -17221.00
-3119.00 838.00 -3357.00 -15408.00
-13137.00 -22608.00 -22851.00 -31724.00
11459.00 -25815.00 -25581.00 -33156.00
4661.00 -19048.00 -36960.00 -31885.00
-29821.00 11017.00 -38654.00 -45496.00
36713.00 -26190.00

Dbank will determine the number of observations in BPASPV.    It will save BPASPV in a group called 
[FIRST] (which need not exist in the current data bank) using double precision storage and the NULL 
frequency.

You may include as many series as you wish in a single    .SER    file.

3. Matrix format (default extension: .MAT)

Matrix format is the simplest format supported by Dbank.    To use this format, your data must be 
organized as a matrix in the input file.    Each column of the matrix is treated as a separate series, while    
each row is regarded as a separate observation on each of the series.    If there are no labels on the first 
line of the input file,    the first column will be named C1.    The second column will be named C2, and so 
on.    You can override this naming convention by providing names for each column on the FIRST line of 
the input file.

Dbank will save the data in a group with the same name as the input file.    Thus, if EXAMPLE.MAT 
contains four columns of data, Dbank will automatically create (assuming it does not exist already) a 
group called [EXAMPLE] with four series named    C1, C2, C3, and C4.    By default, the series are saved 
in the current data bank using double precision storage and the NULL frequency.

The following is an example of a MATRIX input file, say FIRST.MAT.      Dbank will create four series (each
with six observations):



-9345.00 -9207.00 -8782.00 -15671.00
 284.00 -11273.00 -5408.00 -14320.00
-14397.00 -4597.00 -8424.00 29784.00
-3535.00 -15129.00 -28069.00 -12718.00
-45256.00 -82949.00 -47575.00 -24242.00
-87484.00 -53245.00 -23455.00 -23423.00

As there are no labels in the input file, Dbank will name the first column 'C1'.    The second column will be 
called 'C2', and so on.    Each column will be saved in the current data bank using the NULL frequency 
and double precision storage.    The columns will be saved in the group called [FIRST] (i.e., the name of 
the input file).

ROUNDING:

Dbank is able to round the input numbers to a given number of decimal places.    Insert the following line 
in your input file:

ROUND n

where    n    is the number of decimal places to round the input number.    If    n    is negative, ROUND 
rounds the input number to the (-n+1)st digit to the left of the decimal point.    You can insert more than 
one ROUND statement in the input file. Once activated, rounding can be switched off by the command

ROUND OFF

4.    AREMOS/CITIBASE ASCII file formats:    CITIBASE ASCII file format is the structure of the ASCII 
file distributed by FAME Software Corporation, which distributes the CITIBASE time series data base on 
the USA economy.    Please refer to their documentation for detailed information on the structure on the 
ASCII file.    AREMOS ASCII file format is the ".TSD" format recognized by AREMOS.

5.    APTECH "GAUSS" Binary Files:    ".DHT" and ".FMT"

A ".DHT" file is the file format created by GAUSS's "ATOG" command.    A ".FMT" is the matrix file format 
created using GAUSS's    "Save" command.    Dbank can read GAUSS binary files (16 and 32 bit versions)
directly.

6. INTERNATIONALIZATION ISSUES

Dbank is now "internationally" aware.    That is, it recognizes and adapts to your preferred settings for the 
Windows list, thousands, and decimal separator.    Hence, if you set the decimal separator ",", Dbank will 
declare "123.678" to be a non-numeric    number.    However, "123,678" will be numeric.

Please ensure that your input format conforms to the settings you are using for these separators.    
Alternatively, you can change your default settings for the above separators to be consistent with your 
desired input format.    Double-click on "Control Panel" and then "International" to do so.    Dbank will 
adapt to the new separators immediately.    You do not need to re-start the program.



Distribution Policy; License Agreement

Please feel free to (i) upload the Dbank distribution file dbankwin.exe to any electronic bulletin board, (ii) 
give copies of the distribution file to potential users, so that others can obtain a copy of Dbank for use in 
accordance with the license agreement below.

Single-User License:

Suggested contribution of US$25.    A contribution of at least US$25 will give you a life-time, 
non-transferable license to use Dbank and future versions thereof.

Institutional/Government/Corporate:

Non-Network License:    A one-time charge of US$25 per machine Dbank is installed on.    This 
license is transferable to another machine.

Per-Cluster License:    A one-time charge of US$250.    This license is transferable to another 
cluster, and is equivalent to 10 "Non-Network Licenses".    A "cluster" is a group of up to 256 
computers with access to Dbank on a common network.

Wide-Area License:    A one-time charge of US$2500.    This license is transferable to another 
area, and is equivalent to 10 "Per-Cluster Licenses".    An "area" is a geographically connected 
region having up to 5000 computers with access to Dbank.

Reselling/Bundling:

If you wish to resell Dbank or bundle Dbank with your own product (e.g., data), the charge is 
US$15 per unit of original sales (excluding upgrades) of Dbank or your product incorporating 
Dbank.    A purchaser then gains either a "Single-User License" or a "Non-Network License" 
mentioned above.    If Dbank or your product is meant for a server or a site, the "Per-Cluster 
License" or the "Wide-Area License" applies respectively; however, the charge is US$150 or 
US$1500 per unit of original sales respectively, not counting upgrades.

A non-profit organization need only pay a maximum of US$1500 per calendar year for bundling 
Dbank with its own products.

A bug report from a reseller or bundler will receive prompt attention.    All resellers and bundlers 
will automatically receive (if electronically possible) all new versions of Dbank incorporating any 
bug fixes or enhancement upgrades.

Refund Policy:

An individual who reports at least one unknown bug in Dbank, or suggests at least one original
feature that is subsequently implemented in the program, gets his/her contribution (up to 
US$25) refunded, or a free "Single-User License" if his/her copy of Dbank is not licensed.    
These persons will be acknowledged explicitly in all future documentation of Dbank.

A new version of dbankwin.exe will be uploaded on (or about) January 1 and July 1 of each year to the 
Internet site ftp.cica.indiana.edu for anonymous ftp downloading from the /pub/pc/win3/util directory.



A personal check drawn on a US bank is acceptable.    If you do not have easy access to US funds, 
please remit in equivalent local currency.    Please provide an e-mail address if available.

Every licensee will receive a formal license (indicating fees paid) to use Dbank.

If you are reporting a bug, please provide an e-mail address (if available) and the time-stamp of your 
version of Dbank which can be read by invoking the "About Dbank..." sub-menu in Dbank's "Help" menu.

Any individual owning an account on NUSNET (National University of Singapore NET) has a free, non-
transferable, individual license to use Dbank.    The National University of Singapore has a free campus-
wide NUSNET license to use Dbank.




